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Chapter 1. IBM Campaign 11.1 system requirements and
compatibility

IBM® Campaign is part of the IBM Marketing Software suite of products. Campaign version 11.1 requires
Marketing Platform 11.1.

Where to find complete system requirement and compatibility information

For a list of IBM Marketing Software product versions compatible with this product and a list of
third-party requirements for this product, see the Recommended Software Environments and Minimum System
Requirements document. This document is posted under Detailed System Requirements on the IBM
Support Portal website: (http:/ /support.ibm.com).

You can also access this document by selecting Help > Product documentation when you are logged in
to IBM Marketing Software.

Prerequisites for using IBM Campaign

Before you begin using IBM Campaign, confirm that your environment meets the following requirements.

» For an improved user experience, use at least a 21" screen.

* For an improved user experience, set your screen resolution to 1600 x 900. Lower resolutions can result
in some information not being properly displayed. If you use a lower resolution, maximize the browser
window to see more content.

* A mouse is best for navigating in the user interface.

* Do not use the browser controls to navigate. For example, avoid using the Back and Forward buttons.
Instead, use the controls that are in the user interface.

* If pop-up blocker (ad blocker) software is installed on the client machine, IBM Campaign might not
function properly. For best results, disable pop-up blocker software while running IBM Campaign.

* Ensure that the technical environment meets the minimum system requirements and the supported
platforms.*

e The correct browser and versions must be used.*

* Clear the browser cache after upgrading or applying any fix pack. This only needs to be done once,
after the application is updated.

* If you use Internet Explorer (IE) with IBM Campaign or any module that uses Campaign flowcharts
(eMessage, Contact Optimization, Interact, Distributed Marketing): To log in multiple times to view
side-by-side information, open IE and log in to IBM Marketing Software. Then select File > New
Session in the IE menu bar. In the new IE browser window, log in to IBM Marketing Software as the
same or a different user.

Important: Do not use any other method to open multiple sessions. For example, do not open a new
tab; do not open another browser session from the Start menu or desktop icon; and do not use File >

New Window in IE. These methods can corrupt information that is shown in the application.

*For details on the items indicated by an asterisk, see the IBM Marketing Software Recommended Software
Environments and Minimum System Requirements.
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IBM Campaign documentation roadmap

IBM Campaign provides documentation and help for users, administrators, and developers.

Table 1. Get up and running

Task

Documentation

Find out about new features, known issues, and
limitations

IBM Campaign Release Notes

Learn about the structure of the Campaign
system tables

IBM Campaign System Tables and Data Dictionary

Install or upgrade Campaign

One of the following guides:
* IBM Campaign Installation Guide
* IBM Campaign Upgrade Guide

Implement the IBM Cognos® reports provided
with Campaign

IBM Marketing Software Reports Installation and Configuration
Guide

Table 2. Configure and use Campaign

Task

Documentation

* Adjust configuration and security settings
* Prepare Campaign for users
* Run utilities and perform maintenance

* Learn about integrations

IBM Campaign Administrator's Guide

* Create and deploy marketing campaigns

* Analyze campaign results

IBM Campaign User's Guide

Improve flowchart performance

IBM Campaign Tuning Guide

Use Campaign functions

IBM Macros for IBM Marketing Software

Table 3. Integrate Campaign with other IBM products

Task

Documentation

Integrate with IBM Engage

IBM Campaign and Engage Integration Guide for IBM Marketing
Cloud

Integrate with IBM Journey Designer

http:/ /www.ibm.com/support/knowledgecenter /SSER4E /|

ourneyDesigner /kc_welcome_journeydesigner.dita?lang=en|

Integrate with IBM Digital Analytics

IBM Campaign Administrator’s Guide: How to configure the
integration

IBM Campaign User’s Guide: Targeting IBM Digital Analytics
segments in campaigns

Integrate with IBM Marketing Operations

IBM Marketing Operations and IBM Campaign Integration Guide

Integrate with IBM Opportunity Detect

IBM Campaign Administrator’s Guide: How to configure the
integration

IBM Opportunity Detect Administrator’s Guide and IBM
Opportunity Detect User’s Guide: How to administer and use the
product
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Table 3. Integrate Campaign with other IBM products (continued)

Task

Documentation

Integrate with IBM eMessage

IBM Campaign Installation and Upgrade guides: How to install and
prepare eMessage components in the local environment.

IBM eMessage Startup and Administrator’s Guide: How to connect
to the hosted messaging resources.

IBM Campaign Administrator’s Guide: How to configure offer
integration.

Integrate with IBM SPSS® Modeler Advantage
Enterprise Marketing Management Edition

IBM Campaign and IBM SPSS Modeler Advantage Enterprise
Marketing Management Edition Integration Guide

Integrate with IBM WeatherFX.

You can integrate WeatherFX with IBM Campaign so that you
can pull weather events into your marketing campaigns.
Campaign version 9 and version 10 users can integrate with
WeatherFX by using the UBX toolkit. For more information, see
https:/ /www.ibm.com /support/knowledgecenter/SSWUA4L /|
Integrations/imc_Integrations/|
Weather_FX_for_IBM_Marketing_Cloud.htmi}

Integrate with IBM Marketing Software Director.

IBM Marketing Software Director Installation Guide: You can
integrate IBM Marketing Software Director with IBM Campaign
so that you can get status of all the running/completed/failed
flowcharts, migrate Camapigns from one Campaign environment
to other, download/delete flowchart logs etc.

Note: Additional integrations may be available that are not listed in this table. See [Product tools and utilities for]

I|!BM CamEaiggl Also see [[BM Solution Engineering Projects|

Table 4. Develop for Campaign

Task

Documentation

Use the REST API

See the IBM Campaign REST API

Use the SOAP API

* See the IBM Campaign SOAP API Specification
» JavaDocs in devkits\CampaignServicesAPI

Develop Java " plug-ins or command-line
executables to add validation to Campaign

* See the IBM Campaign Validation PDK Guide
* Java-docs in devkits\validation

Table 5. Get help

Task

Instructions

Use the IBM Knowledge Center

Go to |http:/ /www.ibm.com/support/knowledgecenter /|
[SSCVKV /product_welcome_kc_campaign.dital

Open online help

When using the IBM Campaign application:

1. Choose Help > Help for this page to open a context-sensitive
help topic.

2. Click the Show navigation icon in the help window to
display the full help.

You must have web access to view context-sensitive online help.
Contact IBM Support for more information about accessing and
installing IBM Knowledge Center locally for offline
documentation.
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Table 5. Get help (continued)

Task Instructions

Get PDFs When using the IBM Campaign application:

* Choose Help > Product documentation to access Campaign
PDFs.

* Choose Help > All IBM Marketing Software documentation
to access all product PDFs.

* Click the links for PDFs during the installation process.

Get support Go to |http:/ /www.ibm.com /| and click Support & downloads to
access the IBM Support Portal.
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Chapter 2. New features and changes in version 11.1

IBM Campaign 11.1 includes a number of new features and changes. These are listed underneath.

For a list of newly supported and discontinued platforms, see the document Recommended Software
Environments and Minimum_System Requirements, which is posted under Detailed System Requirements on
the IBM Support Portal (http:/ /support.ibm.com).

Upgrade Paths
* Supported upgrade path via installers: 11.0.1 -> 11.1 only.
* Customers at 11.0 -> Fast upgrade to 11.1.

Fast Upgrade

IBM Campaign 11.1 supports the fast upgrade approach. This approach allows upgrades from version 8.6
onwards to version 11.1. This helps customers bypassing the multi-step upgrade. The Fast Upgrade
approach is also useful in reducing upgrade downtime. The approach is provided for IBM Marketing
Platform, IBM Campaign, IBM Contact Optimization, IBM Marketing Operations, IBM Interact for
upgrade from 8.6.x version onwards. For details, refer to the Fast Upgrade documentation released with
version 11.1.

Kerberos on Cloudera Impala Hadoop data source

Campaign now provides Kerberos authentication on Cloudera Impala Hadoop data source. The 11.1 IBM
Campaign Installation Guide details the installation process in Chapter 5. Enabling Kerberos on Cloudera Impala
Hadoop data source. This support is provided with Cloudera Hadoop instance using Impala for Linux and
Windows Operating System. AIX Operating System is not supported

Campaign Database Support - SQL 2017

Campaign now supports SQL 2017 System and User database.

Campaign Application Server Support

Tomcat application server v9.0.13 and JBOSS application server v7.1.0 is supported with IBM Marketing
Software product suite deployment. Deploying an EAR file is not supported on the Tomcat Application
Server.

Campaign Operating System Support

Campaign now supports SUSE 12 SP3 operating system.

Campaign unica_acclean utility for specific Datasource

Prior to 11.1 version, unica_acclean utility deletes all the orphan tables and files from all the datasources
configured in Campaign. No option available to delete orphan tables and files from particular datasource
or a list of datasources. To avail this facility, -D command line option to specify the name of datasources
is implemented in Campaign 11.1.

e.g. unica_acclean -0 "log.txt" -w orphan -D "Test", this command will create a log.txt file which contains

list of orphan tables and files available in "Test" datasource. You can pass the list of datasource name
separated by ','(comma).
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Improved performance of IBM Campaign and UBX Integration

Multi-threaded implementation of the UBX event download and ETL process. Instead of single thread, 10
parallel threads will be used to speed up the overall IBM Campaign and IBM UBX integration.

The History tab

The History tab in Campaign lists the history related to Campaign flowcharts. Numerous events are
audited. For details, refer to the IBM Campaign User Guide > Chapter 3. Designing flowcharts > The
History tab.

Similarly, the History tab in Sessions lists the history related to session flowcharts. Numerous events are

audited. For details, refer to the IBM Campaign User Guide >Chapter 10. Session flowcharts > The
History tab (Session).
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Chapter 3. Fixed defects in IBM Campaign 11.1

The following defects were fixed in Campaign 11.1.

Table 6. Campaign fixed defects

ID Fixed defect

HMA_276788 REST API call to update a Select box type offer attribute was not working. This issue has
been fixed.

HMA-243794 Change in behavior with respect to the Static attributes:
Now if Static attribute is marked 'Mandatory', user has to provide value to it
in offer template as well as in offer
If the attribute is marked as Non Mandatory then it can be kept blank while creating offer
template as well Offer.
This issue has been fixed.

HMA-273682 After decreasing the key fields from 3 to 2 within a remapped dimension table, the
key fields would go missing and the user was unable to add new key fields.
This issue has been fixed.

HMA-243794 Change in behavior with respect to the Static attributes:
Now if Static attribute is marked 'Mandatory', user has to provide value to it
in offer template as well as in offer
If the attribute is marked as Non Mandatory then it can be kept blank while
creating offer template as well Offer.
This issue has been fixed.

HMA-249091 In Campaign, numeric user variable was not visible in parameter list for french
Locale. This issue has been fixed.

HMA-284695 Specifying absolute URL with port 80/443 for proxy server configuration caused
Table Mapping and Flowchart screens to not render. This issue has been fixed.

HMA-238613 IBM Campaign would throw errors and also TCS pages were not editable after
adding a 'nosniff' header in the httpd.conf file of IBM HTTP Server to avoid
Security vulnerability. Add the following header in the httpd.conf file:
Header set X-Content-Type-Options: nosniff
This issue has been fixed.

HMA-284094 Performance issue was observed in session listing page. Action taken to improve
performance in session listing page.
This issue has been fixed.
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Table 6. Campaign fixed defects (continued)

ID

Fixed defect

HMA-285974

User was able to send mail from Email process box even though Email process

box was stopped by user. This issue has been fixed.

HMA-284605

If the text file used as input in select process box contains blank line in middle of records,
then Campaign ignores rest of records after blank line and reaches to end of file without
reading all records. This issue has been fixed.

APAR PO05460,
HMA-202320

When there is a scenario of A-> B-> C where A may be Select box, B is either Segment or
Sample box and C is Mail List/ Call List box, if the connection between A and B is broken
and restored, C (i.e.,, Mail/Call List) reported error "17583 Contact History is tracked at
different audience".

This issue is fixed.

HMA-231900

Custom Cell Attribute of type 'select box' and marked as 'Mandatory' with some default
value assigned to it, was not populated in TCS after a flowchart containing bottom-up cell
was run.

Now, if a custom cell attribute of type select box is marked as Mandatory and has a default
value assigned to it, it's default value will be populated for bottom up cells once the
flowchart is save/run.

This issue has been fixed.

HMA-238613

IBM Campaign would throw errors and also TCS pages were not editable after
adding a 'nosniff' header in the httpd.conf file of IBM HTTP Server to avoid
Security vulnerability. Add the following header in the httpd.conf file:

Header set X-Content-Type-Options: nosniff

This issue has been fixed.

HMA-283866

Whenever user have SMS process box configured to output the email in mapped field, it
will fail if email id is not valid. This should not be the case as in SMS process box, email
should not be mandatory field.

This issue has been fixed.

HMA-242477

The User variable value would not get forward to the Campaign trigger correctly
on the Windows platform when the value contained double quotes. This issue has

been fixed.

HMA-267333

Estimated row counts are showing the largest tables row count, despite not
being selected within the flowchart, when segments are used in the preceding

Select process box. This issue has been fixed.

HMA-244840

When a Select process is run and a temp table is involved - and the processing takes some
time, the user stops the process box run with Right-Click, then "Run > Stop". The system,
which is carrying out an "insert into" the temp table, does not cancel the query but simply
drops the temp table, locking the database

This issue has been fixed

HMA-285603

When opening an offer for editing and eventually for saving ('Save Changes'),

each time was taking about 45 seconds. This issue has been fixed.
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Table 6. Campaign fixed defects (continued)

ID

Fixed defect

HMA-282212

Campaign logs could not be accessed from other users even after setting all

the permissions. This issue has been fixed.

HMA-285141

Special characters not allowed in Campaign attribute display name. This issue has been
fixed.

HMA-285673

select All and clear All buttons in email process box did not function

properly. This issue has been fixed.

HMA-278386

Select Box - String type attribute doesn't allow special characters in 'Source list of available
values'

This issue has been fixed.

285576

When user gave "\" in the subject line for Email process, Email Process Box run

was failing. This issue has been fixed.

HMA-286373

Engage integration email/sms/push process box does not clear contact list if existing
contact list is selected at heavy load before sending emails.

Engineering team to add getJobStatus API call before sending emails or sms or push. When
you run a Email PB and a new contact list is created in Engage

In the campaignweblog look for the below line in
"Status of purgeCL is:"

This issue has been fixed.

HMA-178983

While using the "Point and Click" query builder in Select

process box in IBM Campaign, the "Value" fields get
pre-populated with the value in previous row in case of AND/OR
condition is used in the query.

This issue has been fixed.

HMA-275961

The token <USER> was not correctly replaced in the Campaign generated query.

What we were getting was DBUSER. This issue has been fixed.

HMA-279498

Find process by name search field did not work with search icon. This issue

has been fixed.

HMA-273533

Folders are arranged in descending order by default under campaign-> campaigns folder.
Icons are sorted in ascending order by clicking on name button in the UL Within same
session or if you log out and log in back, in both of these cases, folders are still sorted in
descending order.

This issue has been fixed.

HMA-285639

Deleting values on the Parameters tab of the Mail-list/Call List process box throws error
"Error parsing user input date".

This issue is fixed.

HMA-222049

IBM Campaign extract process does not write to DB2 database when flowchart is
configured with two extract processes and the second extract process contains a derived
field that uses French accented characters in the name of the derived field.

This issue is fixed.

Chapter 3. Fixed defects in IBM Campaign 11.1




Table 6. Campaign fixed defects (continued)

ID

Fixed defect

HMA-278001

Attempts to change currency offer attribute value in Mail List/Call List
process box resulted into error "Error parsing user input
currency value". This has been fixed.

NOTE: Value specified must have 2 digits after decimal point

HMA-284465

Campaign email process box was failing when Portuguese characters were provided

in the email subject line in Weblogic. This issue has been fixed.

HMA-285974

User was able to send mail from Email process box even though Email process

box was stopped by user. This issue has been fixed.

HMA-282295

unica_acclean utility was crashing when run against a datasource in Campaign that

has the word "datasource" in it's name. This issue has been fixed.

HMA-185519

When Platform/Campaign/UDM are installed (only these products), you are unable to log
out of the suite until a UDM page is visited

This issue has been fixed.

HMA-285348

Under certain scenario related to custom macros the flowchart session file continue growing
in size with every save of the flowchart even though there is no change done in the
flowchart.

This issue has been fixed.

HMA-278392

In Merge process box, user was not able to select/check cell (or extend the

first column) with Google Chrome This issue has been fixed.

HMA-282915

Segment to Response process box does not insert data into Response History if first
Segment returns zero records. This issue has been fixed.

HMA-244840

In certain situation, when Campaign runs a query of "INSERT INTO... SELECT FROM
.." and joins base table, temporary table and extract table, the 'SuffixOnInsertSQL'
value was inserted twice which was breaking the query and generating an error.

This issue has been fixed.

HMA-282130

Trying to remap an audience level that has been deleted used to leave application

in unusable state. This issue has been fixed.

APAR PO07143,

The Campaign permissions do not work as per design for flowchart objects

HMA-266014
when the permission is state is Not Granted'. This issue has been fixed.
Add this below JVM parameter to enable this fix.
-DPERMISSION_NGR=true
HMA-232874 Security Policies for Catalogs would not work as expected for a certain case.
This issue has been fixed.
HMA-241870 In a certain scenario, the scheduled runs page displayed status as 'Running' though the

flowchart had completed its scheduled run. This issue has been fixed.
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Table 6. Campaign fixed defects (continued)

ID

Fixed defect

HMA-274738

The user would be unable to select multiple data-sources from Select -> Advanced tab->

Pre/Post processing SQL. This issue has been fixed.

HMA-283590

Persistent Derived Fields are not shown in next select box for GERMAN/FRENCH user

This issue has been fixed.

HMA-282367

While configuring maillist PB if a used offer has a date type of attribute to input cell. Then
on the parameters tab, Select a row from the Assigned value column and click on the
Assign Value button and from the "Assign the following value to all selected attributes”
drop down select Calendar. It is observed that a corrupted string 'date’ is displayed when
you click calendar on the Assign Value of Parameters tab of the Maillist PB

This issue has been fixed.

HMA-273652

The server process crashes when Max size is set to zero and Create extract tables is checked
in Segment process.

This issue has been fixed.

HMA-270614

An error occurs when the user tries to load/delete table catalog which is saved as XML
with data folder specified.

This issue has been fixed.

HMA-269729

Persistent Derived field created in English locale is not displayed in French locale.

This issue has been fixed.
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Chapter 4. Known issues in IBM Campaign 11.1

Campaign 11.1 includes the following known issues.

Table 7. Campaign known issues

ID Known issue

13460 When the Export to File option is unchecked on the Fulfillment tab of the Mail List process,
the Summary File option is enabled but should not be.

175825 When defaultBehavioriWhenOutputToFile is set to Create New File, it works only when you

select a new output (export) file for the first time. If you try to change the existing output
file and select a new output file, then the option Append to Existing Data gets selected by
default.

It can be changed manually to Create New File.

APAR 198495,
PO05293, 198494

For a custom macro, if a user account has assigned as Not Granted permission for a stored
object (Custom Macros, Flowchart Templates, Stored Derived Fields, etc.), the custom macro
can be used to edit, delete, add, move all stored objects regardless of permissions.

PO06172, 222049

204347 LARGE_DATA: Browser Crash - Mail List process box with 700 segments - Save with 512
offers to each segment.

211253 File-based input with multiple columns containing date in different format does not read
the date correctly.

212890 Boolean type column on Amazon Redshift is recognized as 'Test' field type in table
mapping.

220474 When the column name of the source table contains Non-ASCII characters and is long
(probably longer than 10 x 3bytes characters in UTFS), the Snapshot process does not run
because the temp table is not created.

220705 Profiling count for Dimension table fields is incorrect and profiling percentage is displayed
as 100% even if profiling is in progress.

APAR 222047, IBM Campaign extract process does not write to DB2 database when flowchart is

configured with two extract processes and the second extract process contains a derived
field that uses French accented characters in the name of the derived field.

APAR 225568,
PO06304, 225572

temptablepostexecutionsql is not run when selecting coremetrics segment.

226981

Campaign navigation URL format and Campaign/conf/config.xml Campaign navigation
format is incorrect when no port is specified during Campaign installation.

230340

Inconsistent behavior for the Mail list process is observed when the data filter is assigned to
Effective date on the Parameters tab in a new Mail list process when compared to an
edited existing Mail list process. The Mail list process does not output a datetime derived
field in the output log file. Changing the effective date parameter values might cause
execution failure of the Mail list.

230606

In a flowchart where fields are extracted and used in a Mail list process, the fields under
Extract Node on the Personalization tab of the Mail list process are different before and
after running the process.

231859

While using the Chrome browser, it takes around 20 seconds to respond while loading the
Personalization tab of the Mail list process if it contains large number of treatments and
offers assigned. For example, a Mail list process with 250 cells, each cells with multiple
offers, each offer having multiple attributes.
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Table 7. Campaign known issues (continued)

ID

Known issue

232502

A Mail list performance issue occurs when the user changes the input in any way and there
is a delay when initially switching tabs. After the user changes the input and switches to
the Treatment or Process tab for the first time, there is a delay of around 10-15 seconds
depending on the number of inputs selected. After this initial delay, there is no delay until
the input is changed.

232835

The Campaign application performance is affected and sometimes an exception error
message is displayed on the Campaign pages when the application is used for a longer
time (some days) with continuous usage. You must restart your Campaign web application
and Campaign Listeners

238789

While using the Chrome browser, when a user opens a Mail list with 600 cells having
multiple offers assigned to each cell, the application stops responding. While using the
Internet Explorer 11 browser, nothing is displayed in the Mail list process box.

APAR 238830,
PO06822, 238832

Roles assignment does not work in Campaign and a user is able to create a custom macro
even if the user does not have the permission to create the custom macro, has the
permission for Folder Owner and Owner roles, and is neither the folder owner nor the
owner.

239142

When the Audience process fails because of an incorrect Count filter expression, and the
user removes the filter expression, adds a Condition, and runs the Audience process again,
the process fails. The Condition is not considered and instead the previous Count filter
expression is used resulting in the failure. To run the Audience process successfully, you
must re-open the Audience process configuration window, click the Condition, Save and
Close. The Audience process now considers the Condition and runs successfully.

APAR 243895,
PO06966, 243897

A space character is converted to '' while profiling.

PMR 223848, 245664

Irrelevant flowcharts turned up in a Campaign when different users access different
flowcharts at the same time, the wrong flowchart seems to be displayed.

PO07170, 267288

248007 Hive Performance: PRE -Single Insert statements executed for loading data in temp tables
(extract) when used with Hive takes 19 minutes for 2000 records.
APAR 267287, Users cannot add an apostrophe in the text for a Derived field or a User variable.

PMR 269280, 269765

Truncate does not function for the DB2 database. The DeleteAsTruncate property specifies
whether, when an output process is configured to REPLACE TABLE, Campaign uses TRUNCATE
TABLE or deletes from the table. When the value is TRUE, Campaign runs a TRUNCATE TABLE
from the table. When the value is FALSE, Campaign runs a DELETE FROM from the table. The
default value depends on the database type, with a large number of clients moving from
Oracle to DB2 the difference in performance is extremely noticeable. The comparison in
performance in Snapshots and Malil lists for customers leaving Oracle to DB2 is drastic.

269785 For the Chrome and Safari browsers, when the locale is set as Japanese, the labels overlap
the buttons in the Save template window.

270528 Use and Profile buttons remains enabled for the Select process when the user selects some
table fields and then applies the search filter in the Select process such that it does not
return any matching table.

270814 Users cannot select values from the On a trigger drop down by using the mouse on the
Scheduler page.

271576 Campaign Application deployment completed with errors on WAS 8.5.0.2. The errors can be
ignored.

271642 A "Please wait..... " message is displayed multiple times in console mode installation
while upgrading from version 10.1 and also for new Installation

271676 The Extract table on the DB2 and Oracle databases is not deleted when In-DB optimization

is unchecked.
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Table 7. Campaign known issues (continued)

1D Known issue

272253 The Campaign application performance is affected when a user opens the Table mapping
window and more than 500 tables are mapped.

2968 Hot keys are not implemented on most of the windows. In the Dojo implementation it is
not possible to use keyboard shortcuts to activate certain functions. Instead the user must
click buttons.

PMR 266519, 75262 Clicking Return to previous page distorts the user interface in some cases. Use the links
within the products to navigate, rather than the browser controls.

N/A When IBM Campaign is deployed in an application server cluster environment with 80
port, the Campaign navigation URL should not contain this port number. For example:
http://<host>.<domain>:80/Campaign should be changed to http://<host>.<domain>/
Campaign. Change the value of the serverURL property under Campaign | navigation on the
Settings > Configuration page.

N/A Mail List process box gets unconfigured with error "31606: History table are changed"
on Flowchart run.

1. There is no issue if the history tables are mapped prior to building a flowchart and
adding a Mail List process.

2. If you do not follow step 1, you can still map the history tables after the error appears.
If you edit the flowchart and configure the process box, the process will run.

N/A After migrating non-ASCII data to Campaign, in some cases you cannot open Campaign
flowcharts on the target system. Session flowcharts open successfully. To work around this
issue, remigrate the campaigns in overwrite mode. You can then open the flowcharts.

TT 062333 Information related to associated products does not appear in offer on Marketing
Operations. When an offer created in Campaign with products associated with it is
imported in Marketing Operations, information about the associated products is not
available in Marketing Operations.

270655 Table Mapping : Table name containing @ is supported while mapping a table, special
characters like @ are should not be supported in Table names. Since Table name containing
@ is supported since some time, this functioning is not updated now.

283637 When user has one maillist PB configured in the flowchart and he adds another maillist PB
in the same flowchart, it is observed that All the values from already configured in
treatment tab, Parameters tab, Personalisation tab of new Maillist PB appear automatically
in any new dragged maillist PB.

281389 While running Campaign in the Upgrade mode, the installer should read the installation
properties files from the previous version response files as we had that response available
at the install location from the previous installation. However, it does not read the
installation properties files from the earlier version response files.

280623 In Sample PB if we specify '3' in "# of Samples/Output Cells" field and Configure [samplel]
with 3 samples having sample sizes as 50%, 50% and "All remaining records" respectively
based on "Random Sample method" then after running Flowchart if we reopen the Sample
PB "Process run results will be lost. Continue?" message is displayed in sample PB when
remaining All check boxed is check.

281697 Query separator in SQL for error "previous statement must be terminated with a semicolon"
- While executing a script generated by the GDPR utility on the SQL server DB, you might
face this error. The generated script will fail to execute as a script. Hence the specified data
will not be deleted from the Campaign system tables

283101 CHROME: "Unable to notify roles/permission changes to Campaign, eMessage OD may be
out of sync". On clicking save changes for the Security Policy displays the following
pop-up, this happens just first time after user logs in and changes anything in the policy
and clicks save changes. Also, this is reproducible just on CHROME. Tested on Chrome V64
and V65.
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Table 7. Campaign known issues (continued)

ID

Known issue

282844

Campaign Offer doesn’t sort on 'Channel' & 'Eff./Exp.Dates'. After clicking on every
column the offers below it should be sorted in ascending order. If you click on the same
column the second time, the offers beneath it should be sorted in the descending order.

283695

Segment process box execution failed with extract enabled to User database for the
IMPALA user DB. This error does not reproduce when extracting to IBM Campaign server.

284436

Platform.war and campaign.war in ear file deployment will not work in Weblogic 12.2.1,
work around is to deploy campaign.war and unica.war separately

287784

The History Tab does not get updated when a flowchart is saved using the unica_svradmin
command utility. This means - The Save event under the History tab for any flowchart
which is saved using unica_svradmin command line utility will not be captured.

287668

Warning "Failed to define class com.sun.jersey.api.,json.JSONWithPadding in Module
deployment. Campaign.war:main" is displayed while deploying or restarting Campaign
deployment in JBOSS application server. This can be ignored.

288228

If the date field uploaded to IMC side is not in mm/dd/yyyy format, the email process box
fails to execute. This data format is required by IMC Importlist API. It works accurately if
DELIM_M_D_YYYY(mm/dd/yyyy) format is used for date while uploading to IMC using
importlist API. .

289135

TOMCAT : Occasionally IBM Platform or Campaign does not gets started after deploying in
tomcat application server. Workaround : delete Campaign and Platform directory available
inside Tomcat webapps directory and delete the content of work directory from the path
where Tomcat is installed.

291021

Multi-threaded UBX event download and processing enhancement, requires ulimit to be set
to unlimited else you will observe "“java/lang/OutOfMemoryError", "Failed to create a
thread" in Campaign web application server.
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Chapter 5. Known limitations in IBM Campaign 11.1

Campaign 11.1 includes the following known limitations.

Table 8. Campaign known limitations

ID

Known limitation

17202

Error 19024: Cannot delete segment folder if the segment was deleted from the folder. A
segment that is deleted from a folder remains as an inactive segment in the folder. Folders
with inactive segments cannot be deleted. This is working as intended.

185854

Big data: Campaign integration with Hadoop-based Hive big data as a user data source is
not tested on MS Windows operating system.

190621

Big data: Campaign with Hive big data as a user database does not support user table
mapping with Base and Dimension levels up to the fourth level hierarchy. If you map a
Base record table with four levels of dimension tables in a Select process box, then build a
query based on the fourth level Dimension table, the query fails with Error 11528. This
issue should not affect big data users because multiple dimensions should not be needed.
By definition, a big data source has a large table of records split across Hadoop nodes (such
as HDFS).

194095

For Redshift database, the error message "Unsupported type timestamps with time zone" is
displayed when exporting data from a Snapshot process box. Timestamp with timezone is
an unsupported PostgreSQL data type on Amazon AWS.

195581

While running a Campaign flowchart, if listener crashes or is stopped, user is not able to
access the running flowchart from the UL Requests are being served by another node of the
cluster but while accessing the flowchart, a pop-up message says "listener failover
occurred..." It may be necessary to restart the master listener.

232032

User can start only one IBM Campaign listener on one server (machine) in case of Listener
clustering.

PMR 243195, 244148

When a column that has the Greek Letters A and B is profiled in Campaign, the system
returns only A along with the count of all the records. After the fix, some of the
non-English characters, which differ only in case (like é and E in French), are counted as
two different values in profiling. English language characters are not counted as case
sensitive.

244482

Deep search lists all the Campaigns that are created through Marketing Operations projects
when Campaign - Marketing Operations integration is on. Campaigns that are created
through Marketing Operations projects when Marketing Operations - Campaign integration
is enabled) are not listed on Campaign list page and are only available on the Marketing
Operations project listing page. Users who do not have the permission to access Marketing
Operations are able to access campaigns which are created through Marketing Operations
projects through Deep search results.

248943

If the user profile database is changed (change in the table column values of audience
record) for fields other than sync fields and the user runs the Email process again, a
negative count is returned for the DUPLICATES parameter from Engage in the Campaign
flowchart log.

N/A

Big data: To perform the UPDATE operation on any process boxes in a flowchart, ensure
that your HIVE tables are configured as transactional tables such that they support the
ACID property. This is a key feature introduced in HIVE version 0.14.

N/A

IBM Interact when configured with IBM WebSphere Application Server: You must configure
IBM WebSphere JVM to use JDK 1.7. When IBM WebSphere Application Server 8.5.5.x is
configured with JDK 1.7 and HTTPS communication, you must use IBM JAVA SDK version
7.0.8.10 or higher.
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Table 8. Campaign known limitations (continued)

ID

Known limitation

N/A

Using multiple SQL statements for raw SQL queries is not currently supported on big data
user datasources. For related information, search the IBM Knowledge Center for Hive query
language conformance.

N/A

Dialog behavior: In certain cases, it is necessary to click twice in order to activate a field or
change a field value.

N/A

The monitorEnabledForEmessage configuration property in Campaign|monitoring is not
currently used.

N/A

Relevant products limitation: When offer management is performed from IBM Marketing
Operations, the "relevant products” functionality, which relates product IDs to offers, is not
available.

N/A

Blank or incorrect results from derived fields in a Mail List process. This can occur in a
process box that uses a derived field that calls a Generated field (UCGF) that changes
value.

Do not use a UCGF in a Mail List derived field if the UCGF is not constant. Also, from the
Parameters tab, do not create a derived field to call a UCGF to populate offer attributes.

N/A

Profiling a Campaign Generated Field (UCGF) does not yield correct results. Some UCGFs
have a value according to the cell or the offer being processed. For cell-related UCGFs, only
the value associated with the first cell appears during profiling.

N/A

The default value for a custom cell attribute does not appear when you open the target cell
spreadsheet. Although the default value is not initially displayed, it will be used. The value
can be displayed or changed by clicking or opening and editing the custom cell attribute in
the target cell spreadsheet.

N/A

The UA_UsrResponseType.Name field cannot contain a left parenthesis followed by a single
quote.

N/A

Use unique TempTablePrefix for each data source when mapping multiple data sources to
same physical database.

If you mapped multiple data sources in Campaign to the same physical database, and you
use the same TempTablePrefix for more than one of the data sources, when you use the
cleanup utility to delete orphaned temp tables, it may falsely identify temp tables as
orphaned, when they are in fact legitimate temp tables defined from a different Campaign
data source.

Any deleted temp tables will automatically be recreated when you rerun affected
flowcharts, but as a best practice, use a unique TempTablePrefix for each data source when
mapping multiple data sources to the same physical database.

If the data sources defined in Campaign map to different schemas in the database, another
solution is to ensure that the database user who runs the cleanup utility does not have
privileges to drop tables in other schemas in the same database.

161323

The error "Login failed. Error 10553" can occur if you try to log in to the Campaign utilities
when the IBM Marketing Platform | Security | login method is set to Windows
integrated login or Web access control. To avoid this issue, change the login type to LDAP
or IBM Marketing Platform prior to using the Campaign utilities..

176377

DB2 10.5 BLU for user DB: No indexing requirement for temp tables in Campaign
datasource. DB2 10.5 (with BLU feature ON) does not require indexing in Campaign.
Campaign has certain properties for datasources, such as TempTablePreTruncateRunScript,
TempTablePostExecutionSQL, and PostTempTableCreateRunScript, where you can provide
SQL or scripts to create indexes on user database tables. If you are using DB2 10.5 as a
customer database, with the BLU feature ON, you do not need to configure any of these
temp table properties.
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Table 8. Campaign known limitations (continued)

ID

Known limitation

201,968,200,241

If two process boxes are moved very close together in a flowchart, the direction of the
connection arrow changes. This limitation affects the visual representation of the arrow. The
process data flow is not affected. The workaround is to move the process boxes farther
apart so the arrowhead changes back to the correct direction.

211293

In IBM Campaign, the built-in macro Current_Date() results in an error when executed
against a Hive 1.2 based Big Data instance. The Hive ODBC driver does not support the
CURRENT_DATE macro to obtain interval values. For example, executing the following
query results in a Hive error:

SELECT DISTINCT customerid FROM Customer_date WHERE
((Customer_date.my_date_mmdyyyy - CURRENT_DATE()) >= 7)

Error: Hive 2 Internal error: unsupported conversion from type: interval_day_time

Workaround: To use the CURRENT_DATE function in a RAW SQL query on Hive with
Hortonworks, execute SQL in the following format:

SELECT DISTINCT customerid FROM Customer_date WHERE (current_date() -
my_date_mmddyyyy ) = interval '0 0:0:0' day to second

213088

If IBM Campaign is installed in a secured environment but IBM Cognos is in an unsecured
environment, Cognos reports will not display when you use Microsoft Internet Explorer 11.
Workaround: If IBM Campaign is configured with HTTPS, also configure IBM Cognos on
HTTPS.

217488

IBM can support the Database Loader for Redshift until the moment Campaign triggers the
Loader Script. Any problems in execution of the loader script are not supported by IBM.

223716

Authentication Bypass Using HTTP Verb Tampering

Instead of applying theHttpVerbFilter.class patch, you can use the following workaround to
ensure application security.

Complete the following steps to update web.xml.
1. Update the web app tag and set the xsd version to 3.0.

<web-app xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins="http://java.sun.com/xml/ns/javaee"
xsi:schemaLocation="http://java.sun.com/xml/ns/javaee
http://java.sun.com/xml/ns/javaee/web-app_3_0.xsd"
id="Platform" version="3.0" metadata-complete="true">

2. Add the following in web.xml.

<!l--[start] WhiteList Http Verbs -->

<security-constraint>
<web-resource-collection>
<web-resource-name>Unica_WhitelList Http_Verbs</web-resource-name>
<url-pattern>/*</url-pattern>
<http-method-omission>GET</http-method-omission>
<http-method-omission>P0ST</http-method-omission>
<http-method-omission>TRACE</http-method-omission>
<http-method-omission>PUT</http-method-omission>
<http-method-omission>DELETE</http-method-omission>
<http-method-omission>PATCH</http-method-omission>
<http-method-omission>0PTIONS</http-method-omission>
<http-method-omission>HEAD</http-method-omission>
</web-resource-collection>
<auth-constraint/>

</security-constraint>

<!--[end] WhitelList Http Verbs -->
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Table 8. Campaign known limitations (continued)

ID

Known limitation

283805

IBM Websphere Application Server 8.5.5 Fix Pack 12 requires IFPI85892 to run IBM
Marketing Software application. An interim fix is available at:

https:/ / www-945.ibm.com /support/fixcentral /swg / selectFixes?parent=ibm%2FWebSphere|
&product=ibm /WebSphere/WebSphere+Application+Server&release= All&platform=All|
& function=fixId &fixids=8.5.5.12-WS-WASProd-IFPI85892&includeSupersedes=0|

283544

On Oracle 12.2 database server following parameters needs to be added in sqlnet.ora file
located under ORACLE_HOME /network/admin/
SQLNET.ALLOWED_LOGON_VERSION_SERVER

User will need to consult with DBA to provide appropriate value to this parameter. Please
refer this link for details: [https:/ /docs.oracle.com/database/121/NETRF /|
[sqlnet. htm#NETRF2016)

N/A

IBM Campaign Integration with Watson Marketing Assistant is not supported on Internet
Explorer.

286705

Two events get generated on the Campaign history tab when user pauses the Campaign
flowchart from Operational monitoring.

287100

History tab data remains in UA_History table even after deleting the Campaign

290172

Cutting off right contents from Relevant offers window.

Workaround: The size of text, apps and other items - under Display should be set to 100%.
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Chapter 6. IBM Campaign Reports Package

The Campaign Reports Package delivers reporting schemas that you can use to track campaign, offer, and
cell performance. To use the Reports Package, Campaign must be integrated with IBM Cognos

For more information, see the IBM Marketing Software Reports Installation and Configuration Guide that is
supplied with IBM Marketing Platform.

The IBM Campaign Reports Package contains the following items:

* Schemas that are registered with IBM Marketing Platform during installation. They describe the
attributes and metrics that represent the product's reporting schema and include:

— Base schemas that are the basis of the reporting schema (with no custom attributes)
— Custom versions of most of the base schemas that rely on the preconfigured custom attributes for
Campaign
— Templates that you can use to create new schemas
* IBM Cognos customizable model and reports to be deployed on an IBM Cognos BI Server

* Reference documentation that describes the IBM Cognos model and the reports. Documentation can be
found in the directory ReportsPackCampaign\cognos11\CampaignDocs.

The Campaign reports retrieve data from one data source: the Campaign system tables.
Reporting Schemas

The following reporting schemas are provided:

* Campaign Views provides the standard attribute views of the Campaign system tables (campaign,
offer, cell, and so on).

* Campaign Custom Attributes is for reporting on custom attributes of campaigns, offers, and cells.

* Campaign Performance is used by reports that display performance measurements starting at the
campaign level over all time or various periods of time (days, months, and so on).

* Offer Performance is used by reports that display performance measurements starting at the offer level
over all time or various periods of time (days, months, and so on).

* Campaign Offer Response Breakout is used by reports that show campaign and offer responses based
on response types.

* Campaign Offer Contact Status Breakout is used for measurement of campaign and offer contacts
based on contact status.

The custom schemas extend the last five of the listed schemas to include the default, preconfigured
response types, custom attributes, and so on.

Templates

If you have additional audience levels, you can create additional reporting schemas for them with the
following templates:

* Campaign Views

* Campaign Custom Attributes

* Campaign Performance

* Offer Performance

* Campaign Offer Response Breakout
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* Campaign Offer Contact Status Breakout
Reports

The reports package contains Cognos example reports that can be accessed from the Analytics menu or
the Analysis tab for a campaign or offer. Reports can also be displayed in portlets on the Dashboard.

The following campaign-specific example reports are available from the Campaign Analysis tab:
* Campaign Detailed Offer Response Breakout

* Campaign Financial Summary by Offer (Actual)

* Campaign Offer Performance by Month

* Campaign Performance Summary by Cell

* Campaign Performance Summary by Cell with Revenue

* Campaign Performance Summary by Offer

* Campaign Performance Summary by Cell and Offer

* Campaign Performance Summary by Cell and Offer (with Revenue)

The following offer example reports are available from the Offer Analysis tab:
* "What If" Offer Financial Summary
* Offer Performance by Day

* Offer Performance Summary by Campaign

The following cross-object example reports include information about multiple objects in Campaign.
These reports are available from the Campaign Analytics page.

"What If" Offer Financial Summary

* Campaign Detailed Offer Response Breakout

* Campaign Financial Summary by Offer (Actual)

* Campaign Offer Performance by Month

* Campaign Performance Comparison

* Campaign Performance Comparison (with Revenue)

* Campaign Performance Comparison by Initiative

* Campaign Performance Summary by Cell

* Campaign Performance Summary by Cell (with Revenue)
+ Campaign Performance Summary by Cell by Initiative

* Campaign Performance Summary by Offer

* Campaign Performance Summary by Offer (with Revenue)
* Campaign Performance Summary by Cell and Offer

* Campaign Performance Summary by Cell and Offer (with Revenue)
* Campaign Summary

 Offer Campaign Listings

* Offer Performance by Day

* Offer Performance Comparison

* Offer Performance Metrics

* Offer Performance Summary by Campaign

The following campaign-specific example report portlets are available on dashboard pages:
* Campaign Response Rate Comparison
* Campaign Return on Investment Comparison
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Campaign Revenue Comparison by Offer
Offer Response Breakout

Offer Response Rate Comparison

Offer Responses for Last 7 Days

Chapter 6. IBM Campaign Reports Package
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Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the documentation, your company's
designated support contact can log a call with IBM technical support. Use these guidelines to ensure that
your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM administrator for
information.

Note: Technical Support does not write or create API scripts. For assistance in implementing our API
offerings, contact IBM Professional Services.

Information to gather

Before you contact IBM technical support, gather the following information:
* A brief description of the nature of your issue.

* Detailed error messages that you see when the issue occurs.

* Detailed steps to reproduce the issue.

* Related log files, session files, configuration files, and data files.

* Information about your product and system environment, which you can obtain as described in
"System information."

System information

When you call IBM technical support, you might be asked to provide information about your
environment.

If your problem does not prevent you from logging in, much of this information is available on the
About page, which provides information about your installed IBM applications.

You can access the About page by selecting Help > About. If the About page is not accessible, check for a
version.txt file that is located under the installation directory for your application.

Contact information for IBM technical support

For ways to contact IBM technical support, see the IBM Product Technical Support website:
(http: / /www.ibm.com /support/entry /portal /open_service_request).

Note: To enter a support request, you must log in with an IBM account. This account must be linked to
your IBM customer number. To learn more about associating your account with your IBM customer
number, see Support Resources > Entitled Software Support on the Support Portal.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan, Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of

the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation

BIWA LKG1

550 King Street
Littleton, MA 01460-1250
US.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases,
payment of a fee.

The licensed program described in this document and all licensed material available for it are provided
by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the
results obtained in other operating environments may vary significantly. Some measurements may have
been made on development-level systems and there is no guarantee that these measurements will be the
same on generally available systems. Furthermore, some measurements may have been estimated through
extrapolation. Actual results may vary. Users of this document should verify the applicable data for their
specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their
published announcements or other publicly available sources. IBM has not tested those products and
cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of
those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without
notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject to change without
notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business operations. To illustrate
them as completely as possible, the examples include the names of individuals, companies, brands, and
products. All of these names are fictitious and any similarity to the names and addresses used by an
actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming
techniques on various operating platforms. You may copy, modify, and distribute these sample programs
in any form without payment to IBM, for the purposes of developing, using, marketing or distributing
application programs conforming to the application programming interface for the operating platform for
which the sample programs are written. These examples have not been thoroughly tested under all
conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.
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Trademarks

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be
trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at
"Copyright and trademark information" at www.ibm.com/legal/copytrade.shtml.

Privacy Policy and Terms of Use Considerations

IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies
or other technologies to collect product usage information, to help improve the end user experience, to
tailor interactions with the end user or for other purposes. A cookie is a piece of data that a web site can
send to your browser, which may then be stored on your computer as a tag that identifies your computer.
In many cases, no personal information is collected by these cookies. If a Software Offering you are using
enables you to collect personal information through cookies and similar technologies, we inform you
about the specifics below.

Depending upon the configurations deployed, this Software Offering may use session and persistent
cookies that collect each user's user name, and other personal information for purposes of session
management, enhanced user usability, or other usage tracking or functional purposes. These cookies can
be disabled, but disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through cookies and similar
technologies. If the configurations deployed for this Software Offering provide you as customer the
ability to collect personal information from end users via cookies and other technologies, you should seek
your own legal advice about any laws applicable to such data collection, including any requirements for
providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer's website terms of use
(e.g. privacy policy) which includes a link to IBM's and Client's data collection and use practices, (2)
notify that cookies and clear gifs/web beacons are being placed on the visitor's computer by IBM on the
Client's behalf along with an explanation of the purpose of such technology, and (3) to the extent required
by law, obtain consent from website visitors prior to the placement of cookies and clear gifs/web beacons
placed by Client or IBM on Client's behalf on website visitor's devices

For more information about the use of various technologies, including cookies, for these purposes, See

IBM's Online Privacy Statement at: http://www.ibm.com/privacy/details/us/en section entitled
"Cookies, Web Beacons and Other Technologies."
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